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UICK START (Features, hidden commands and tips - Please read)

You set up search criteria by selecting one or more of the buttons on the
front panel. The more search criteria you give UltraFind (ie: the more
buttons you set), the faster it will locate the files you want.

To turn a button off, hold the <Option> key down and click it, or press your
<Clear> or <Escape> key if you want to turn all buttons off.

When you press [Scan], UltraFind scans your machine (and any mounted
volumes) for files matching the criteria you gave it, and loads these into a
File List window from which you can select the file(s) you want.

To select multiple files hold the <Shift> key down, or drag the mouse down

over them. To select all the files use <Command-A> (Select All).

To see where the files are, you can make UltraFind display in 3 different
view modes using the View Pop-Up menu, or by pressing your Space Bar.

You can get UltraFind to sort the list by File Name, Size, Kind or Date

Last Modified, by clicking on any heading while you are in the "Finder
View". This allows you to see at a glance the differences between duplicate
files, or to find out which is the latest version of a document.



* To get information on a file, simply move the cursor over the file's small
icon and UltraFind will display a File (or Folder) Information Box.

* You can read text inside documents -without opening them- by selecting a
file (or multiple files) in the list window and pressing the [Read] button.
This also allows you to locate and copy selected text out of the file.

(If you hold the <Option> key down and click [Read], UltraFind will read the
file's Resource fork)

* If you want UltraFind to open (show) a file's parent folder, hold the
<Option> key down and press [Open].
If you want UltraFind to quit after opening your file, hold the <Command>
key down and press [Open].

» To regularly find things like "All work done today", "All Email for Joe"
or "All JPEG images on the server" etc., save your settings as a Preset
Search Routine (under Routines in the MenuBar).

* During very long searches (i.e: searching for text within files), you can
click the small green UltraFind icon to 'hide' UltraFind while you carry on
with your work. It will continue scanning in the background and notify you
by flashing an icon in the menu bar when it has finished.

* UltraFind's List Window should be resized to the height of your screen to
make it easier to see long lists of files. Simply drag the List Window
vertically to the top of your screen and then pull the bottom part down.

*  On some 24 Bit monitors UltraFind may require more memory to utilise it's
off-screen G-World (with low memory it will use ordinary drawing routines
which can give a slight screen flicker). To use off-screen G-World and get
a smoother screen display, inclrease UltraFind's memory to roughly 1400K.

NSTALLING THE COMMAND KEY

UltraFind can be opened by pressing <Command-Option-F> on your keyboard.
If this function has not already installed itself, select "Preferences" from the
File Menu and click "Enable". (You may use any key combination you wish,
however the best setting is usually <Command-Option-F>)

To enable this function, UltraFind carries it's own System Extension which it
will automatically install into the Extensions folder in your System folder
when you click the 'Enable' button. You will then need to restart your machine
in order for the new Command Key to work.

If you have any anti-virus software running, you must temporarily disable it
while UltraFind installs the Extension or the function may not work properly.

INDING FILES BY CONTENT (TEXT SEARCH)

The "File Contents" button searches for words, keywords or parts of sentences



within files, such as:

* names * phone numbers * parts of addresses * keywords * captions
* product codes e chemicals e Zip codes e authors » descriptions

Using this function you can (for example) find all letters, electronic mail and
faxes sent to a particular person, find files containing references to names,
customers, places, objects, prices, ingredients, dates, etc., or even files
relating to events such as a "meeting" in "Tokyo" in "December".

The File Content Dialogue box allows you to search on 1, 2 or 3 main words
(or parts of sentences). The Thesaurus allows you to add variables to any of
these 3 main words.

XRef and the UltraFind Thesaurus

If 'XRef' is checked, each main word can cross reference a built-in Thesaurus
of sub-words. Therefore, for example, searching on the word "automobile"
will also find "vehicle, car, motorcar, jeep, station wagon, truck" etc.

UltraFind's Thesaurus is User-maintained, and is supplied empty so you can
specify your own groups of sub-words, specific to your company or setup.
The Thesaurus window has 2 lists: The first list contains main words (these
are words you would enter in one of the 3 text search fields), the second list
contains the sub-words. (The relationship between the 2 lists is One-to-Many.)

To add a new main word (ie: to create a word group), open the Thesaurus, select
the first list (Searching on:) and press the Add button. To add sub-words to the
group, select the second list and press the Add button.

TIP: If you double-click a word in the Thesaurus' list, it will be placed in the
current active text search field.

Match Any / Match All

The Match ANY or Match ALL settings allow you to specify if UltraFind should
find files containing any 1 of the words you enter, or if it should only find files
containing all 3 of the main words.

Search Data / Search Resources

All Macintosh files are made up of 2 parts: a Data part and a Resource part
(known as Data or Resource Forks). Text is normally contained in the Data
fork, therefore the normal setting is 'Search Data'.

Use 'Search Resources' only if you are searching for embedded keywords,
captions, credits etc. in image files (JPEG, Photoshop, Fetch etc.), sounds,
QuickTime movies etc., or as a last resort if the 'Search Data' setting failed
to find files you know contain the right word.

News Agencies and Picture Desks: JPEG images supplied by Reuters, AP and
other agencies carry captions and keywords in the Resource Fork, therefore
use the 'Search Resources' setting (turn off Search Data) to search text in
image files. (to speed up the search, also set the File Type to JPEG.)

Scanning in the Background
Because searching for text can be very slow, we have designed UltraFind so



that it scans in the background. If you need to search very large disks or
networks, just hide UltraFind (press the small green UltraFind icon) and
carry on with your work. When it has finished it will alert you by flashing
an icon in the menu bar.

Speeding up the search

If possible, you should narrow down the search by also using the File Kind
button to specify the Type of files UltraFind should search through (ie: if it
only has to search through MacWrite files for text, then set the Creator to
"MacWrite". This way UltraFind will not search through unnecessary files.

NOTE: Searching by file contents does not distinguish between upper and
lower case characters.

NOTE: You can pause the scan at any time if you see that UltraFind has found
something you need. If you want to read the document to see if it really does
contain the word(s), click the [Read] button. The text you are looking for will
be located and highlighted for you automatically.

NOTE: It is possible that some software may not hold text in a readable format,
and UltraFind may not be able to scan for text inside some compressed archives.

INDING FILES BY TYPE (OR CREATOR)

The "File Type/Creator" button allows you to search for specific types of
files including:

* Pictures * Sounds * Movies * Fonts * XTensions or Filters
» System Files e Applications * Documents * Text Files * Archives etc.

Using this function you can find groups of files such as Fonts, Documents,
Images, Email, Sounds, QuickTime Movies, Photoshop Plug-ins, etc., files
created by specific applications, and groups of documents of the same type.

Creator List: This is a list of all the applications on your system. Selecting
an application from the list will find all files created by the application or
owned by the application.

Type List: This is a list of common Macintosh file types. Selecting any one of
these will find all files of that type. (NB: If used together with the Creator list,
the file types supported by the Creator application will replace the standard
types in the list. ie: it would be useless looking for a '"MacWrite' 'Sound' file.)

Document List: You can customise this pop-up menu, adding document types
specific to your machine or company. To add a document to the list, simply

select 'Add New Document' and show UltraFind an example of the type of document
you want added to the list. (If you want to remove a document from the list,

hold the <Option> key down and select the document name to be removed.)

NOTE: Programmers can simply enter the 4 character Creator or Type
signature straight into the fields alongside the pop-up menus.



NOTE: UltraFind displays file Creators and Types in the INFO window (the
window you get when you move the cursor over a file's icon in the List window).
If you don't know what Type or Creator a certain file is (or if you want to find
out), get UltraFind to find a similar file and then move the cursor over the

file's icon to display the info window.

INDING FILES BY ATTRIBUTE

The "File Attributes" function allows you to search for files by various system
attributes including the Label colour.

Finder Label (finds all files of a certain colour)

Alias (finds all Aliases)

Invisible (finds files which are not normally visible in the Finder)

Locked (finds files which have been locked, either by an application or by

the User from the Finder’s Get Info box)

* Has INITs (finds files which have initialization code - mainly used by the
system)

* Has Custom Icon (finds files which are not showing their true icon in the

Finder)

INDING FILES BY DATE

The "File Date & Time" function allows you to search for files created or
modified (last updated) before, after, on or between any date.

Both the 'Find files created...' and the 'Find files modified...' pop-up menus
contain a set of finding options. Depending on what you are searching for, you
will need to choose whether you should search by the 'created' date or the
'modified' date. For example, finding files created 'yesterday' will list only
files that were created (made) yesterday, but finding files modified ‘yesterday
will list everything you worked on yesterday, regardless of when the files
were actually made.

’

The Calendar is there to assist you with selecting a date, in case you do not
remember what date "Monday, two weeks ago" was. Place the cursor in either
the 'Find files created...’ or the 'Find files modified...’ fields and choose any
date from the Calendar. If you prefer, you can simply type a date directly into
one of the two fields.

INDING FILES (OR FOLDERS) BY SIZE

The "File Size" function is designed to work together with other search criteria
and allows you to specify what size files should be found.

Used on its own, this function can find empty files (less than 1K), empty
folders (less than 1K), and files which are taking up a lot of room on your
disks (for example, greater than 10,000K).

You can also use this function to find folders by size, by enabling the 'Folders'



button instead of the 'Files' button. UltraFind will list all the folders found,
together with the total size of each folder. (The total size is the real size of a
folder, including all folders within that folder. Therefore when in this mode
UltraFind will not total the sizes of all folders at the top of the listing window,
but will display 'Size n/a' [not applicable] instead.)

SING THE LIST WINDOW

All files found that match your search criteria are displayed in the List window.
(We reccomend you resize the list window to the full height of your monitor.)

The list can be viewed in 3 different ways:

* Finder View: Shows the file name, size, kind and date last modified.
You can sort the list by clicking on any of these headings.

* Hierarchical View: Shows the relative location of each file -including all
parent folders-in the Hierarchical Filing System.

* Path View: Shows the full pathname to the file.

To switch views, just press the Space Bar.

Whichever viewing mode you are in, you can select any file by clicking on it

or select groups of files by dragging down the list, or select multiple groups

by clicking with the <Shift> key down. You can select the whole list using
<Command-A>. When the list is sorted by file name, you can also select any file
by typing the first character of it's name.

When one or more files are selected, you can perform several actions on the
files, including:
- Using any of the buttons at the bottom of the List window to copy, open, etc.
Clear any unwanted files from the list by pressing the <Delete> or <Clear> key
(note this is not the same as 'Trash' and does not delete the file).
Use any of the functions available in the Edit Menu.
Use any of the functions available in the Additions Menu.
Double-click on any file to Open it.
<Option>+Double-click on any file to open it's parent folder.
<Command>+Double-click on any file to quit UltraFind after opening the file.

GETTING INFORMATION

To display information on a file or folder in the list, move your cursor over the
file's icon. The cursor will turn into a blue 'Info Cursor’, and an information
box will be displayed at the bottom of the screen.

APPENDING MULTIPLE SEARCHES

UltraFind can append the results of multiple searches to the files already in

the list window, so that different groups of files can be listed and sorted together.
While in the list window, you can append a new scan by pressing <Command-N>
or by selecting 'Append New Scan' from the Search menu.

EXPORTING THE FILE LIST



You can export the find results as a list from any of UltraFind's 3 list windows
by selecting 'Export File List as Text' from the File menu. The export function
generates a Tab-separated text file, which you can either print as is, or
import into a wordprocessor, spreadsheet or database.

LIST WINDOW ICONS

UltraFind uses it's own icon groups to denote similar groups of files, so that all
images -regardless of what application they belong to- present a picture icon,
all text files present a text document icon, etc. This allows you to see groups
of files rather than an endless list of unrelated icons (if you want to verify a
file's real icon, simply move the cursor over it).

XAMINING & READING TEXT IN FILES

You can "Read" text inside any document by selecting it and pressing the [Read]
button. This function allows you to read most documents without having to open
them, read documents you can't open when you don't have the Creator application,
recover text from crashed, damaged documents, and read any keywords,

captions or credits carried in certain picture files, sound files and movies etc.

You can select and copy text out of the Read window for pasting into another
application (but you can not edit text with UltraFind).

UltraFind 'reads' files by reading the data directly on the hard disk, not by
actually opening or running the file. Therefore it can not display any of the
documents original formatting. If the document contains pictures or other
items, these will display as random control characters.

The Read function reads text contained in the file's Data Fork. If you need to
read the Resource Fork instead, hold the <Option> key down when you
press the [Read] button. (News Agencies and Picture Desks should always
read the Resource Fork to see keywords and captions in JPEG images).

NOTE: UltraFind reads the Resource Fork automatically if it does not find
text in the Data Fork.

EARCHING VOLUMES & NETWORKS

Any volumes to search need to be available (mounted) on your desktop in order
for UltraFind to see them. Therefore if you are searching network volumes (or
even remote volumes over Apple Remote Access) you will need to mount them
first, via your chooser or server aliases.

Mounted disks appear in the Volume Menu from which you can select or deselect
the disks or remote volumes to be scanned. At Starup, UltraFind defaults to
searching all local volumes.

UltraFind will detect any new volumes which you may have mounted since it
was launched, and will add them to the menu, separating your local from your



network volumes. (NB: If UltraFind was in the background it may have missed
a new volume mount event, so check the Volume menu to be sure.)

NOTE: To search only one volume from a long volume list, hold the <Option>
key down and select the volume from the menu. All others will be turned off.

Searching over Apple Remote Access

Searching a remote volume over a modem using ARA is exactly the same as
searching your own local disks, files from the remote system will list in
UltraFind's list window and you can perform all the usual copy, move etc.
functions on them. However the speed at which UltraFind can operate over
a modem will depend on the connection speed, and it will naturally be much
slower than normal. Unless you have a very fast connection we would not
recommend searching for text within files over a modem.

Checking Network Security

Set UltraFind to scan for just Files and Folders (no other options) and log in

to your server using a restricted Username (or Guest etc.). UltraFind will find
and display everything the 'Username' has access to on the server. Viewing this
information using UltraFind's Hierarchic view will give you a map of what

can be seen by 'Username' when they log on.

Unsearchable Volumes?

Some file systems do not support Apple's catalog search facility (PBCatSearch).
Such volumes will appear in grey and will not be searched. This includes
volumes served by PC servers running Novell NetWare 3.1., and WindowsNT

or UNIX volumes mounted using NFS/Share. (We may release a version that
can scan WindowsNT and UNIX mounted volumes in the future.)

HE ROUTINES MENU
SAVING PRESET SEARCH ROUTINES

UltraFind's Routines menu allows you to save your search criteria, so that you
can repeatedly find groups of files. This allows you to customise UltraFind,
adding powerful compound commands specific to your setup or business, and
will save you much time and effort.

For example, a Routine for finding letters, faxes or Email will produce a list
of all your mail which, sorted in date order, will give you immediate access
to open or read your correspondence no matter where the files are on your
system (or network). Likewise, a Routine for finding Today's work will
ensure you never have to run around your folders again looking for files you
only just made a few hours ago...

You can add as many Routines as you need to the Routines Menu, and call them
whatever you like. UltraFind automatically assigns command keys to the first
10 menu items.

To create a Routine:

1) Use UltraFind to find an example of the group of files you want.

2) Once it has found files of the type you want, choose "Save Current Settings"
from the Routines Menu.

3) Type in a name for your new Routine search menu and press Save. -That's it!



To remove a Routine menu item: simply hold the <Option> or key down and
select the menu item to be removed.

AutoScan

When saving a Routine, ensure that AutoScan is checked if you want UltraFind
to scan for those files straight away. Leave AutoScan unchecked if you just want
the search criteria restored (ie: where you might want to change or add more
criteria before scanning).

HE ADDITIONS MENU

The Additions menu enables UltraFind to load extra utilities (plug-ins) which
we will release in the future, and make available (mostly free of charge) from
online systems and the internet. The first of these Additions (and the only one
at the moment) is CopyRight-IT.

USING COPYRIGHT-IT™

CopyRight-IT is an UltraFind Addition that enables producers and creators of
artwork, documents and music (or any material which is electronically
distributed) to apply a copyright ByLine to a Macintosh file, or series of files.
Once applied, the ByLine will show up in the Finder's 'Get Info' box and will
remain attached to the file wherever it goes. The ByLine can contain the words
"Copyright 1995 John Doe" as well as your contact information.

To set up CopyRight-IT with your information, select 'Configure' from the
CopyRight-IT menu.

NOTE: For security reasons, if a file already carries copyright information,
CopyRight-IT™ will not overwrite it.

NOTE: CopyRight-IT™ is of course not going to stop a determined user from
hacking your file or illegally copying your work anyway. But it's a start. And
doing something is better than nothing. Until we invent a better way, this is it.
At the very least, people will know how to contact you if they find and like
your work.

(CopyRight-IT ©1993-1995 UltraDesign Ltd., London)

SING THE BACKUP FEATURE
FINDING FILES BY BACKUP STATUS

"Files Not backed up" finds files which have been modified (updated) since the
last time you backed them up. Used together with the ‘Backup’ button in the list
window, this function allows you to use UltraFind to backup your files without
the need for extra software.

Please note that this function is not meant to be a fully-fledged backup solution,
files backed up will simply be copied to your backup folder, in no particular
order, and UltraFind will reset the backup dates on the original files so that



it knows each time what has and what has not been backed up.

To see how much stuff there is that needs backing up, turn the 'Files Not backed
up' button ON, leave all the other buttons off, and press Scan.

(If this finds a large amount of files, then you have either not backed up your
files for a long time, or your regular backup software is not setting the file
backup dates properly.)

To backup files in the list, simply select all (<Command-A>) and press the
Backup button. You will be asked to select a destination for the files, this can
be a folder on any Macintosh disk, SyQuest, Optical etc., but it must have

at least as much free space as the total amount of files you want

to backup. If it does not, then select only as many files as will fit, and repeat
the process again with other disks.

The next time you search for 'Files Not backed up' UltraFind will not list files
that have been backed up, but only those that have been modified since.

If you only need to regularly backup certain files, like your spreadsheets or
databases etc., then also set the File Type to match your database files so that
only these are searched for their backup status.

ENERAL INFORMATION

* For security reasons, UltraFind will not delete any files itself. If you tell
it to trash a file it will simply put it in the Trash - it is up to you to
empty the Trash later, in the normal way.

e Consistent with the normal operation of the Macintosh Finder, moving files
between volumes does not remove the original item. After moving files
across volumes you must press 'Trash' if you want to delete the original item.

* UltraFind has a limit on the amount of files you can display in one list.
This is approximately 2500 files. We have never encountered anyone mad
enough to want to find so many files in one go, but one never knows...

* This version of UltraFind can not search inside compressed files.

* If you have a file copy accelerator installed, UltraFind will use it. In
particular it works very well with Copy accelerators like CopyDoubler™,
CopyRight Pro™ and the super-fast RunShare™ (RunShare™ is
distributed in the UK by Simms International Plc., Tel: 0181 213 5000).

OFTWARE LICENSE AGREEMENT

By using this Software you are agreeing to be bound by the terms of this
license. If you do not agree to the terms of this license you must remove this
Software from your system and not use it.

DISCLAIMER



This Software is provided "as is" without warranty of any kind. UltraDesign
Technology Ltd. does not warrant, guarantee, or make any representations
regarding the use or the results of the use of this Software or accompanying
documentation in terms of their accuracy, reliability or otherwise.

You expressly acknowledge and agree that the use of this Software is entirely
at your own risk.

RESTRICTIONS

You may not sell, lease, rent or loan this Software or distribute this Software
in any commercial format without the prior written consent of UltraDesign
Technology Ltd.

You may not reverse engineer, decompile, or disassemble this Software. You
may not modify, adapt, translate or create derivative works based upon this
Software or it's interface in whole or in part. You may not modify or remove
any insignia or proprietary notices from this Software.

You may not copy the look and feel of this software; UltraDesign Technology
reserves all rights to certain unique and original design features in this
software's user interface such as the UltraFind Control Interface, the
InfoCursor, Preset Search Routines, the UltraFind Thesaurus. These features
are expressly proprietary to UltraDesign Technology worldwide and may not
be copied or emulated in whole or in part without prior consultation and
permission and acknowledgment of UltraDesign Technology.

UltraFind and CopyRight-IT are trademarks of UltraDesign Technology Ltd.

ECHNICAL SUPPORT

Technical Support is free to registered users only, please quote your User
registration number in all support communications. Please note that we are
only able to provide support from 09:00 to 18:00 hours (London Time).

Where possible, please Email us as it cost's you less and allows us to answer
your query better and faster. (Support is also available from our World Wide
Web Server at:  www.demon.co.uk/ultratec/support.html)

UltraDesign Technology Ltd. Email: support@ultratec.demon.co.uk

5/39 St.George's Square

London SW1V 3QN Tel: +44-171 931 0010
United Kingdom Fax: +44-171 630 9105

BTAINING UPGRADES, EXTRA COPIES OR SITE LICENSES

UltraFind is upgraded periodically to incorporate new features and take
advantage of new Apple technologies. We try to ensure that the latest version
is always available on the main global communications systems: CompuServe,
NiftyServe, America Online, eWorld, AppleLink and Genie.



On the Internet, you can get the latest upgrades, news and support from our
World Wide Web Server at:  www.demon.co.uk/ultratec/ultrafind.html

If you have Internet ftp access, you will always find the latest version in
the UltraTec archive at: ftp.demon.co.uk/pub/mac/ultratec

UltraFind upgrades are also available on CD-ROM from the major Shareware
distributors and should be available from your local Macintosh User Group.

If you use Apple Remote Access you can download the latest upgrade directly
from our ARA Server here at UltraTec in London, please see your registration

card for our ARA number and log-in details.

If you would like more User Licenses for UltraFind please contact us for prices
of Site Licenses for 5, 10, 50, 100 and Unlimited Users.

ItraDesign Technology Ltd. designs and develops software exclusively for the
Apple Macintosh. Thank you for using UltraFind, we hope it serves you well.

Julian and Steve Linford

Special thanks to:
Katsuji Onishi, Tohru Okai, Jim McCormik, David Lee Rutledge, Bill Goodman,
Joe Sternlicht, lan Walker, Nigel Hunt, Cary Wyman, Michael & David McCann.



